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True/False 

Indicate whether the statement is true or false. 

  

  1.  The presence of hidden tools in the Tools panel is indicated by a small black triangle beside a tool icon. 

REF:  Illustrator 1-9 

  

  2.  New users should not try to use quick keys in Illustrator CS4; they should wait until they are more experienced with the 

program. 

REF:  Illustrator 1-11 

  

  3.  The word pixel is short for picture element. 

REF:  Illustrator 1-18 

  

  4.  Vector graphics consist of anchor points and line segments. 

REF:  Illustrator 1-19 

  

  5.  Guides are created only by dragging them from the rulers. 

REF:  Illustrator 1-36 

  

  6.  While the Direct Selection tool is no more than a means to an end for selecting and moving objects, the Selection tool is in itself 

a drawing tool. 

REF:  Illustrator 1-36 

  

  7.  When an object is turned into a guide, it retains its attributes, such as its fill, stroke, and stroke weight. 

REF:  Illustrator 1-37 

  

  8.  Bitmap graphics are an excellent choice for working with type and typography. 

REF:  Illustrator 1-19 

  

  9.  To apply a fill or a stroke to an object, you must first activate the appropriate button. 

REF:  Illustrator 1-22 

  

  10.  Tweaking is always a part of the drawing process in Illustrator. 

REF:  Illustrator 3-5 

  

  11.  When you use the Direct Selection tool to select an anchor point connected to a curved segment, you will expose the point's 

direction lines. 

REF:  Illustrator 3-10 

  

  12.  When two paths are joined at a corner point, manipulating one path will affect the other. 

REF:  Illustrator 3-11 

  

  13.  Tracing a scanned image in Illustrator is looked down upon by professional designers. 

REF:  Illustrator 3-18 
 

  14.  Typographic attributes would include the font, leading and horizontal scale. 

REF:  Illustrator 3-24 

  

  15.  The Eyedropper tool samples only an object's fill color. 

REF:  Illustrator 3-24 

  

  16.  To add a fill to an open path, Illustrator first must close the path by connecting the open points with a path. 

REF:  Illustrator 3-25 

  

  17.  When an object is selected, clicking a second object with the Eyedropper tool applies the second object's fill and stroke attributes 

to the selected object. 

REF:  Illustrator 3-27 

  



 

  18.  Assembling an illustration with multiple objects will test your fluency with the stacking order commands. 

REF:  Illustrator 3-28 

  

  19.  The Free Transform tool is best for performing quick transformations. 

REF:  Illustrator 4-4 

  

  20.  All transformations are executed from a fixed point, referred to as the point of origin. 

REF:  Illustrator 4-4 

  

  21.  Click a transform tool, press [Alt] (Win) or [option] (Mac), then click the artboard - where you click will be the point of origin 

for the transformation and the tool's dialog box opens. 

REF:  Illustrator 4-5 

  

  22.  If you transform an object from its center point, select a second object, then apply the Transform Again command, the second 

object is transformed from its own center point. 

REF:  Illustrator 4-5 

  

  23.  In the Transform panel, all values refer to the bounding box of an object only if the bounding box is visible. If not, the values 

refer to the object's center point. 

REF:  Illustrator 4-7 

  

  24.  By default, an object's X coordinate represents its horizontal distance from the bottom right corner of the artboard. 

REF:  Illustrator 4-8 

  

  25.  The Outline Stroke command is useful for making concentric circles. 

REF:  Illustrator 4-12 

  

  26.  The Axis panel offers a quick and simple solution for aligning selected objects along the axis you specify. 

REF:  Illustrator 4-27 

  

  27.  When two overlapping objects are made into a compound path, the backmost object creates a hole in the object in front. 

REF:  Illustrator 4-16 | Illustrator 4-17 
 

  28.  When multiple objects are made into a compound path, they function as a group; if you click one with the Direct Selection tool, 

all the objects will be selected. 

REF:  Illustrator 4-16 | Illustrator 4-17 

  

  29.  Compound paths can be released and returned to their original component objects. 

REF:  Illustrator 4-16 | Illustrator 4-17 

  

  30.  Like a compound path, a compound shape is two or more paths that are combined in such a way the holes appear wherever paths 

overlap. 

REF:  Illustrator 4-16 | Illustrator 4-17 

  

  31.  When you select any two objects and apply the Make Clipping Mask command, the backmost object functions as the mask, and 

the object in front is masked. 

REF:  Illustrator 4-31 | Illustrator 4-32 

  

  32.  Shape modes and pathfinders are a group of preset operations that help you combine paths in a variety of ways. 

REF:  Illustrator 4-20 

  

  33.  The Pathfinder panel has ten buttons. 

REF:  Illustrator 4-22 

  

  34.  You can duplicate a layer by dragging it onto the Create New Layer button. 

REF:  Illustrator 5-5 

  

  35.  The Show option displays all the artwork on the artboard that is contained on the layer. 

REF:  Illustrator 5-6 

  

  36.  When you click on a layer in the Layers panel, all of the objects on that layer are selected. 

REF:  Illustrator 5-7 
 



 

  37.  If you delete artwork that is on a sublayer, the sublayer is deleted as well. 

REF:  Illustrator 5-7 

  

  38.  If you make a copy of artwork that is on a sublayer, a new sublayer is automatically created. 

REF:  Illustrator 5-7 

  

  39.  Clicking the right side of a layer is the easiest way to select all of the objects on the layer. 

REF:  Illustrator 5-7 

  

  40.  When you drag the Indicates Selected Art button from one layer to another, the selected artwork moves to the new layer, and the 

layer moves as well. 

REF:  Illustrator 5-29 

  

  41.  Layers must be showing and unlocked in order to be merged. 

REF:  Illustrator 5-15 
 

  42.  When a layer is set to not print, its name is bolded in the Layers panel. 

REF:  Illustrator 5-25 

  

  43.  You cannot export Illustrator layers to Photoshop. 

REF:  Illustrator 5-21 

  

  44.  You can cut and paste artwork only within its own layer, not from one layer to another. 

REF:  Illustrator 5-13 

  

  45.  Pressing [Ctrl] (Win) or [Command] (Mac) and clicking the Toggles Visibility button toggles the artwork on the layer between 

Preview and Outline view mode. 

REF:  Illustrator 5-20 

  

  46.  When you click the Show All command, all the hidden objects are selected when they are revealed. 

REF:  Illustrator 2-5 

  

  47.  Once text is flowed into an object, you can no longer manipulate the object as you would have previously. 

REF:  Illustrator 2-10 

  

  48.  An imported Swatches panel is editable. 

REF:  Illustrator 2-28 

  

  49.  The location of a midpoint in a gradient can be changed. 

REF:  Illustrator 2-20 

  

  50.  A linear gradient can be positioned from left to right, top to bottom, or on any angle. 

REF:  Illustrator 2-20 

  

 

Multiple Choice 

Identify the choice that best completes the statement or answers the question. 

  

  51.  The default workspace is called  ____. 

a. [Default] 

b. Essentials 

c. Basic 

d. Workspace 1 

REF:  Illustrator 1-8 

  

  52.  To switch between activating the fill and activating the stroke, you should press which key? 

a. 1 

b. spacebar 

c. + 

d. X 

REF:  Illustrator 1-22 

  



 

 

 

 

 

  53.  When you press [Alt] (Win) or [option] (Mac) while dragging an object, the pointer becomes a(n) ____ pointer. 

a. selection 

b. double-arrow 

c. context-sensitive 

d. insertion 

REF:  Illustrator 1-29 

  

  54.  ____ a transform tool to open the tool’s dialog box. 

a. Double-click 

b. Click 

c. Right-click 

d. Hover over 

REF:  Illustrator 1-30 

  

  55.  An inch contains how many points? 

a. 6 

b. 12 

c. 24 

d. 72 

REF:  Illustrator 1-5 

  

  56.  A pica is how many points? 

a. 6 

b. 12 

c. 24 

d. 72 

REF:  Illustrator 1-5 

  

  

Case Based Critical Thinking 

 

Mark is a well-known illustrator and artist who started his own design firm two years ago. Because Mark’s business is more 

about illustration than anything else, he is constantly challenging his staff to hone their skills in Adobe Illustrator. He finds that, 

though many have “played around” with the software, most of his designers are Photoshop gurus who don’t fully appreciate the 

abilities and the concepts associated with Illustrator. 

  

  57.  One of Mark’s logo designs - created exclusively in Illustrator - was used on the cover of a corporate annual. Now the client has 

called and asked for the same logo to be used in an outdoor billboard campaign. One of Mark’s designers worries that Mark’s 

logo is too small to be used on such a large display - that the reduction in quality will be unacceptable. Based on this interaction, 

Mark realizes that his designer doesn’t understand the concept of ________. 

a. bitmap graphics c. interpolation 

b. pixels d. resolution independence 

REF:  Illustrator 1-19 

  

  58.  Mark’s team is working on a complex layout for a children’s book that will utilize the same few Ilustrator graphics at various 

sizes and rotations. Many of them will be positioned as mirror images, and all of them will be positioned precisely, based on a 

complex grid. Mark knows that this project will challenge his team’s abilities working with _________. 

a. shape tools c. transform tools 

b. drawing tools d. selection tools 

REF:  Illustrator 1-30 
 

  59.  Mark’s team is excited to be working on a project that involves many geometric illustrations, but the big challenge is that the 

artwork demands precise positioning. In many cases, objects must abut precisely, with no gap and no overlap. Mark tells his 

team that they should rely heavily on which of the following Illustrator features? 

a. grouping objects c. dragging and dropping 

b. smart guides d. all of the above 

REF:  Illustrator 1-27 

  



  60.  Mark’s junior designer is working with the shape tools. Mark tells him to make a square, then modify the square so that it is a 

kite shape. Mark is trying to familiarize his junior designer with ________. 

a. the direct selection tool c. the reflect tool 

b. the rotate tool d. the scale tool 

REF:  Illustrator 1-36 

  

  61.  Tweaking refers to what? 

a. adding an anchor point to a path 

b. converting a path into a guide 

c. rotating an object precisely 

d. making small improvements 

REF:  Illustrator 3-5 

  

  62.  What is the name of the command that allows you to save any view of the artboard? 

a. Save View 

b. New View 

c. Edit View 

d. Fit In Window 

REF:  Illustrator 3-4 

  

  63.  Views that have been saved are listed where? 

a. at the top of the Window menu 

b. at the bottom of the Window menu 

c. at the top of the View menu 

d. at the bottom of the View menu 

REF:  Illustrator 3-4 

  

  64.  The Average and Join commands are under which menu? 

a. Edit 

b. Select 

c. View 

d. none of the above 

REF:  Illustrator 3-9 

  

  65.  When two anchor points are aligned on only one axis and they are joined, what happens? 

a. they are united as one point 

b. they are averaged 

c. they are united by a path 

d. none of the above 

REF:  Illustrator 3-5 

  

  66.  When the Pen tool is positioned over an anchor point on a selected path, ____. 

a. the Pen tool becomes the Delete Anchor Point tool 

b. the Pen tool becomes the Add Anchor Point tool 

c. the Pen tool becomes a selection arrow 

d. the Pen tool does not change 

REF:  Illustrator 3-5 
 

  67.  When you remove an anchor point from a closed path by using the Cut command, which of the following choices best describes 

what happens? 

a. the anchor point is pasted to the artboard 

b. the paths attached to the point remain intact 

c. the path is broken 

d. the anchor point becomes a selection arrow 

REF:  Illustrator 3-5 

  

  68.  A corner point can join which of the following? 

a. two straight segments 

b. one straight and one curved segment 

c. two curved segments 

d. all of the above 

REF:  Illustrator 3-11 

  



 

 

 

 

  69.  Which general term does Illustrator use to refer to that which has been applied to an object to affect its appearance? 

a. symbol 

b. attribute 

c. filter 

d. none of the above 

REF:  Illustrator 3-24 

  

  70.  The default Miter Limit is ____. 

a. 2 

b. 4 

c. 6 

d. 8 

REF:  Illustrator 3-31 

  

  71.  Which of the following letters is an example of an open path? 

a. C 

b. O 

c. D 

d. none of the above 

REF:  Illustrator 3-25 

  

  

Case Based Critical Thinking 
 

Mark finds that most of his designers are mostly Photoshop gurus and aren’t fully up to speed with using the Pen tool to draw 

objects in Illustrator, and because of this, much of their line work and choices for stroking effects are unsatisfactory. He also 

finds that they are mostly unaware of the basic concepts behind the Live Paint feature and how they relate to standard Illustrator 

working methods. 

  

  72.  Mark finds that his designers don’t know any of the terms used to describe different components of a path. He tells his designers 

to compare a path drawn with the Pen tool to a road through the woods. With that analogy, a smooth point would occur at these 

places in the road: 

a. curves c. corners 

b. hills d. a & b but not c 

REF:  Illustrator 3-10 
 

  73.  To explain the concept of the Live Paint feature to his team, Mark knows he must reinforce the basic rules of painting objects in 

Illustrator. He creates two circles in Illustrator with no fill and no stroke, then positions them so that one is overlapping half of 

the other. He refers to this as “the artwork.” He then tells his team that - without using Live Paint - the total number of different 

fills and stroke colors that could be applied to “the artwork” is: 

a. 1 fill color and 1 stroke color c. three different fill colors and two different stroke colors 

b. 2 different fill colors and two different stroke colors d. three different fill colors and four different stroke colors 

REF:  Illustrator 3-36 

  

  74.  To further explain the concept of the Live Paint feature to his team, Mark uses the same example. He creates two circles in 

Illustrator with no fill and no stroke, then positions them so that one is overlapping half of the other. He refers to this as “the 

artwork.” He then tells his team that - using Live Paint - the total number of different fill and stroke colors that could be applied 

to “the artwork” is: 

a. 1 fill color and 1 stroke color c. three different fill colors and two different stroke colors 

b. 2 different fill colors and two different stroke colors d. three different fill colors and four different stroke colors 

REF:  Illustrator 3-36 

  

  75.  An object's position on the artboard is indicated using which of the following? 

a. smart guides 

b. snap to point 

c. X and Y coordinates 

d. rulers 

REF:  Illustrator 4-8 

  



 

 

 

  76.  You can use the Free Transform tool to do which of the following? 

a. scale an object from any point of origin 

b. rotate a copy of an object 

c. perform a non-uniform scale 

d. all of the above 

REF:  Illustrator 4-7 

  

  77.  The ____ button on the Pathfinder panel creates a single, merged object from the area where two or more objects overlap. 

a. Intersect shape mode 

b. Divide pathfinder 

c. Unite shape mode 

d. Minus Back 

REF:  Illustrator 4-21 

  

  78.  When the Outline Stroke command is applied to a stroke path, the width of the closed path that is created is ____. 

a. a number that you input in the Outline Stroke Options dialog box 

b. by default, half the height of the original stroked path 

c. the same as the stroke weight of the original stroked path 

d. one-half the stroke weight of the original stroked path 

REF:  Illustrator 4-13 

  

  

Case Based Critical Thinking 

 

Now that his team has been using Illustrator regularly and getting comfortable with the software, Mark is excited to work with 

them on some of the more interesting features and to share with them some of his special techniques. 

  

  79.  Mark is talking with his team about clipping masks. Some of the junior designers are having trouble with the concept that there’s 

more to the masked art than you can see, so Mark tells them that the best analogy for a clipping mask is which of the following? 

a. a white stencil positioned over a pink wall c. a hole in a wall 

b. the matting in a picture frame d. all of the above 

REF:  Illustrator 4-31 

  

  80.  Mark draws a red heart shaped object on the art board. He then creates a gold star that is larger than the heart object and 

positions the star over the heart. He selects both then applies the Intersect shape mode. What does he now see on the art board? 

a. a red heart c. a red star 

b. a gold heart d. a gold star 

REF:  Illustrator 4-21 | Illustrator 4-23 

  

  81.  If you drag a layer onto the Create New Sublayer button on the Layers panel, which of the following is true? 

a. the result will be a duplicated layer 

b. the result will be a duplicated sublayer 

c. you cannot drag a layer onto the Create New Sublayer button 

d. none of the above 

REF:  Illustrator 5-5 

  

  82.  In the Layer Options dialog box, options are available for ____. 

a. locking 

b. unlocking 

c. showing 

d. all of the above 

REF:  Illustrator 5-6 

  

  83.  When the Preview option is activated, what happens? 

a. a Print Preview of the artboard is shown 

b. a Print Preview of only the objects on the layer is shown 

c. all of the objects on the artboard will be in Preview mode 

d. none of the above 

REF:  Illustrator 5-6 

  



  84.  ____ layers is the process of dragging one layer into another. 

a. Merging 

b. Manipulating 

c. Outlining 

d. Condensing 

REF:  Illustrator 5-12 

  

  85.  When is a layer is automatically duplicated? 

a. only when it contains one object and that object is copied 

b. only when all the objects on the layer are copied 

c. only when all the objects on the layer are copied and the Paste In Front or Paste In Back command is applied 

d. a layer is never automatically duplicated 

REF:  Illustrator 5-7 

  

  86.  When is a layer automatically deleted? 

a. only when it contains one object and that object is deleted 

b. only when all the objects on the layer are deleted 

c. only when all the objects on the layer are deleted using the Delete key 

d. a layer is never automatically deleted 

REF:  Illustrator 5-7 

  

  87.  When is a sublayer automatically deleted? 

a. when the object on the sublayer is deleted 

b. when the sublayer contains more than one object and one object is deleted 

c. only when the sublayer contains more than one object and all the objects are deleted 

d. a sublayer is never automatically deleted 

REF:  Illustrator 5-7 
 

  88.  Which of the following four answers is the best choice for describing how to use a clipping mask with layers? 

a. the clipping mask and the objects to be masked must be in the same layer 

b. the top object in the clipping set becomes the mask 

c. a <Group> sublayer can be a clipping set, and the top object in the group will function as the mask 

d. all of the above 

REF:  Illustrator 5-26 

  

  89.  When you place grouped artwork into a layer, a sublayer is automatically created with the name ____. 

a. <Default> 

b. <Layer> 

c. <Group> 

d. <Sublayer> 

REF:  Illustrator 5-13 

  

  

Case Based Critical Thinking 

 

Mark’s team is working on complex artwork for a 120-page corporate annual. Mark tells his team to be certain that all the 

artwork that they create is created with layers. His Photoshop gurus are experts at using layers in Photoshop, but Mark is curious 

to see how they will translate those abilities to working with layers in Illustrator. 

  

  90.  Much of the artwork involves repeating artwork in the same illustration. Mark tells his designers to keep in mind the difference 

between duplicating layers and copy/pasting artwork, which is that ________. 

a. when you copy/paste art, the art is pasted onto the same 

layer unless you target a new layer for the paste 

c. both a & b 

b. when you duplicate a layer, all of the artwork on the 

original layer is duplicated onto the new layer. 

  

REF:  Illustrator 5-5 

  

  91.  Text generated by the Type tool is positioned on a path called what? 

a. text path 

b. baseline 

c. stroke line 

d. type index 

REF:  Illustrator 2-4 

  



 

  92.  Text preferences are listed under what category? 

a. Type 

b. Units & Undo 

c. Guides & Grid 

d. Type & Grid 

REF:  Illustrator 2-4 

  

  93.  The Unlock All command is under which menu on the menu bar? 

a. Edit 

b. Object 

c. Select 

d. Window 

REF:  Illustrator 2-11 
 

  94.  You can turn any object into a guide by clicking which command? 

a. Show Guides 

b. Release Guides 

c. Convert to Outlines 

d. Make Guides 

REF:  Illustrator 2-11 

  

  95.  When text is flowed on a path, which feature of the Character panel allows you to increase or decrease the distance of the text 

from the path? 

a. vertical scale 

b. baseline shift 

c. the Offset Path command 

d. none of the above 

REF:  Illustrator 2-16 

  

  96.  When you copy text on a path, ____. 

a. you copy both the text and the path 

b. you copy the text only 

c. you copy the path only; the text must be reentered 

d. none of the above 

REF:  Illustrator 2-19 

  

  97.  When you float your cursor near the endpoint of the gradient control bar, the ____ icon appears. 

a. flip 

b. rotate 

c. scale 

d. copy 

REF:  Illustrator 2-31 

  

  

Case Based Critical Thinking 
 

Mark’s design team has taken on a number of projects that involve display text and gradients. Mark considers typography to be a 

fine art, and he thinks that gradients are often a very effective component of good Illustrator design, so he is excited to take this 

opportunity to put his team through typography and gradient boot camp. 

  

  98.  One of Mark’s designers is having difficulty with tracking and kerning - specifically, when to use tracking and when to use 

kerning. Mark asks four other designers to provide an analogy for tracking and kerning. He is pleased with all four analogies, but 

he says that the best of the four analogies is that tracking is to kerning as ________. 

a. group is to individual c. book ends are to books 

b. hugging is to pinching d. brushing is to flossing 

REF:  Illustrator 2-4 

  

  99.  Mark knows that his designers aren’t programmers, but he feels it’s important that a designer has some amount of understanding 

of how a program works. He asks his team that, working in Illustrator, if they wanted to create a linear gradient but couldn’t use 

any of the  gradient tools, they could create the gradient with which of the following ________. 

a. stroked lines c. both a and b 

b. filled rectangles   

REF:  Illustrator 2-20 
 



 

  100. Mark considers gradients to be an important design component for many types of Illustrator artwork. He tells his team that 

gradients can be ________. 

a. radial or linear c. made of multiple colors 

b. used to fill multiple objects simultaneously d. all of the above 

REF:  Illustrator 2-2 
 


